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新特性

新特性

Autodesk Maya 新特性

欢迎使用 Autodesk® Maya® 2012 新特性。

Maya 2012 提供了用于预先可视化和游戏原型生成的新工具集，扩展了模拟功能
集，并开创了集成制作流程的更佳方法。

借助高性能视口、创建基于节点的渲染过程表示的能力、扩展的摄影机序列器工具

集以及新的摄影机装配，美工人员可以先完善和展示自己的构思，再实现最终生产。

并且，可编辑的运动轨迹提供了增强的动画体验。

此外，增强的 Nucleus 解算器及其模块，与新的物理解算器相结合，可帮助您在更
短的时间内创建大量逼真的效果。

同样地，Autodesk 产品之间的单步互操作性、产品之间一致的 F 曲线编辑器以及对
向量位移贴图的新增支持，使 Maya 2012 可更轻松地集成到生产制作流程中。

观看 Maya 2012 突出功能视频，并阅读以下章节，了解有关此版本中所有新功能。

常规和性能

Maya 2012 新增了多个单步工作流，使得可以在 Autodesk 3D 应用程序之间无缝
发送场景数据。此外，此版本中的动力学和 nDynamics 领域以及 Viewport 2.0 进
行了一些性能改进。

■ 位于第 6页的常规新特性

■ 位于第 6页的性能新特性

1
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基本

新设计的“项目窗口”（Project Window）可以更灵
活地访问和编辑项目文件位置。改进的默认项目结构更易

于管理项目目录以及为插件数据创建自定义目录。

请参见位于第 7页的基本新特性。

资源和文件引用

新的“名称空间编辑器”（Namespace Editor）设计
提供了更多的控件，用于创建和管理场景对象的名称空间

组织。功能改进包括弹出窗口中的对象列表，更好的名称

空间层次显示等。

请参见位于第 8页的资源和文件引用的新特性。
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建模

新的“发送到”（Send to）功能提供了一种简单的方
法，单步地将对象和各种形式的数据从 Maya 发送到
Mudbox。

新的“交互式分割工具”（Interactive Split tool）是
可通过“编辑网格”（Edit Mesh）菜单访问的若干新选
项之一。通过它可以精确地拆分多边形网格上的面。此

外，新的“在网格上投影曲线”（Project Curve on
Mesh）选项可用于在多边形曲面上投影曲线，而新的“使
用投影的曲线分割网格”（Split Mesh with Projected
Curve）选项可用于分割和分离多边形曲面上的边。

还有三个与“显示操纵器工具”（Show Manipulator
Tool）相关联的新滑块。

请参见位于第 9页的建模的新特性。

动画

可编辑的运动轨迹为动画师提供了可以直接在 Maya 场景
中编辑关键帧位置和计时的快速工作流。运动轨迹显示动

画模型，而无需使场景的“曲线图编辑器”（Graph
Editor）。

“摄影机序列器”（Camera Sequencer）的更新包括
新的播放列表，可以更高效地管理、改进多轨迹音频和添

加“Ubercam”，使得您可以快速将所有快照输出到一
个摄影机中。

此外，“曲线图编辑器”（Graph Editor）的一些改进
提供了更简化和熟悉的曲线编辑工具，尤其适用于在管线
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中使用多个 Autodesk 应用程序的动画师。新选项和首选
项包括自动切线类型、相邻关键帧捕捉、单击曲线编辑以

及缩放多个关键帧的“区域工具”（Region Tool）。

请参见位于第 11页的动画的新特性。

装配

Maya 中的新的 HumanIK 角色设置工具使用 Autodesk
MotionBuilder 的可视焦点、直观工具以及简化的互操作
性，改进了关键帧和重新定位的工作流Maya 和
MotionBuilder 之间的通用工具可以轻松地从
MotionBuilder 重新定位运动捕捉动画，并应用于 Maya
中的装配设置。

请参见位于第 15页的装配的新特性。

动力学和 nDynamics

新的“流体效果”仿真方法可以创建真实的液体倾泻，飞

溅和沸腾效果。流体的其他新特性包括新的输出网格选

项、改进的自动调整大小和增强效果外观和行为的多个新

属性。

进一步开发的 Nucleus 统一仿真框架包含性能更好的多线
程 nParticle 碰撞和 nCloth 自碰撞，能够更好地控制
Nucleus 力的每个对象局部重力和风，以及小比例破坏效
果的刚性 nCloth 壳。

“效果资源”（Effects Assets）的新特性提供了广泛的
易于使用的自定义效果，包括火、烟雾、爆炸、灰尘，熔

化和烟火。

对于 Autodesk Maya Entertainment Creation Suites，
动力学和效果提供了单步 Softimage ICE 互操作性使您可
以利用 ICE（交互式创造性环境）来为 Maya 场景创建效
果。

请参见位于第 18页的动力学和 nDynamics 的新特性。
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渲染和渲染设置

现在可以通过“Hypershade”轻松地创建渲染过程节
点并直接在“渲染视图”（Render View）中查看这些
过程的输出。此外，还可以使用渲染过程、渲染目标和标

准 Maya 着色工具节点，并直接在“渲染视图”（Render
View）或通过批渲染可视化结果，来创建基本合成图形。

新的“Viewport 2.0”特性包括改进对大多数 Maya 零
件的支持，例如，操纵器、工具、形状和节点。新的效果

（如屏幕空间环境光遮挡、运动模糊、景深，多样例抗锯

齿也包括在内）。

Viewport 2.0 提供了两个新的性能选项：“使用顶点动画
缓存”（Use Vertex Animation Cache）和“线程
依存关系图求值”（Thread Dependency Graph
Evaluation）。

也可以预览“Viewport 2.0”中输入的指定给任何标准
Maya 着色网络纹理的 Ptex 纹理。

此外，新的“Maya 硬件 2.0”（Maya Hardware
2.0）渲染器允许您为“Viewport 2.0”执行命令行渲
染或批渲染到磁盘或“渲染视图”（Render View）。

请参见位于第 27页的渲染和渲染设置的新特性。

文档

请阅读我们对提供的 Maya 帮助、Maya API 和其他学习资源所做的修改。此外，
您可以找到有关新的学习资源的详细信息。

请参见位于第 30页的文档的新特性。

API

Maya 2012 开始，您可以使用新的扩展属性功能为给定的节点类添加属性，使其
显示为静态 Maya 属性。

请参见位于第 29页的 API 的新特性。
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API Guide 和 API Reference 现在是 Maya 帮助中的单独部分，并包括新的功能
（例如：多个从 API Guide 到 API 元素的链接（例如类和函数，以及 API Guide
示例代码中的颜色编码语法）。

请参见 http://www.autodesk.com/maya-sdkdoc-2012-enu。

常用功能新特性

互操作性

现在，可以将新场景数据或对当前打开的场景的更新从 Maya 发送到 Softimage、
MotionBuilder 或 Mudbox。可以从“文件”（File）菜单访问新的一键式选项。

cmdScrollFieldExecutor 命令中添加了新选项

向 cmdScrollFieldExecutor 命令中添加了一些新选项，包括：区分大小写的全部
替换、查询总行数的标志以及启用搜索函数换行的标志。有关详细信息，请参见命

令文档和版本说明。

改进了 Direct Connect 支持

在 Windows 和 Mac OS X 操作系统中，Direct Connect 支持现已更新为 Direct
Connect 2012，Maya 2012 支持导入和导出更多的文件格式，并可在 Windows
32 位和 Windows 64 位系统之间提供更好的奇偶校验。

性能新特性

以下各部分介绍 Autodesk Maya 2012 中的一些性能改进。

基本

■ 改进 MDGContext 矩阵求值：改进相同帧时间内的多个矩阵的求值。

■ 已提供以下两个新选项来改进“Viewport 2.0”的性能：“顶点动画缓存”
（Vertex Animation Cache）和“线程依存关系图求值”（Thread
Dependency Graph Evaluation）。有关详细信息，请参见“渲染器 >
Viewport 2.0”。
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■ 性能优化可以减少 Maya Ascii (.ma) 文件的保存次数，特别是对于包含较大网
格的场景。

动力学和 nDynamics

■ 对流体效果的改进包括交互式绘制和流体输出网格的增强功能。请参见位于第

20页的流体效果的新特性。

■ 附加的 Nucleus 解算器线程将改进回放 nCloth 和 nParticle 模拟的性能。请
参见位于第 25页的nCloth 新特性和位于第 26页的nParticle 新特性。

基本新特性

“项目窗口”（Project Window）更新

改进的“项目窗口”（Project Window）可以更轻松地组织和自定义 Maya 项
目文件。这些更新包括：

主项目位置和次项目位置

从“项目窗口”（Project Window）创建新项目时，
Maya 现在将项目文件组织到主项目位置和次项目位置。
主项目位置为基本项目数据（例如场景文件、纹理文件以

及渲染的图像文件）提供目录。次项目位置是主位置为提

供其他项目管理而创建的子目录。

可以为每个主项目目录和次项目子目录指定不同的位置，

也可提供自定义目录名称。新增的浏览功能可用于快速导

航到每个项目目录所需的位置。

转换器和自定义数据位置

项目窗口也为转换器数据提供可自定义的目录。可以使用

默认位置，也可以指定与产品级制作流程更好地相对应的

自定义位置。

也可以使用“添加新文件规则”（Add new file rule）
命令，将新的自定义目录添加到 Maya 项目。
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帮助首选项

新的“帮助位置”（Help Location）选项已添加到 Maya“首选项”
（Preferences）中，以便适应“Maya 帮助”新的发布方式。

选择首选项

在“首选项”（Preferences）窗口的“选择”（Selection）区域中，有三个
新的修改器：

■ 自动选择资源（Auto-select asset）

■ 跟踪选择顺序（Track selection order）

■ 选择类型效果激活（Selection type effects active）

资源和文件引用新特性

名称空间编辑器的改进

改进“名称空间编辑器”（Namespace Editor）使您
能更好地控制场景对象的名称空间组织的创建和管理。编

辑器以新的树视图显示为特色，从而可以更轻松地查看名

称空间的层次结构。

其他改进包括：

■ 现在“列出内容”（List Contents）在弹出窗口中显示对

象列表，而不是仅在“脚本编辑器”（Script Editor）窗口

中。

■ “选择所有空的名称空间”（Select All Empty）使得选择

所有空的名称空间并对其进行操作更容易。

■ “收拢到子名称空间”（Collapse to Child）将移除空的祖

先名称空间。

■ “设置当前名称空间”（Set Current）提供了可视化指示

器和对当前名称空间的控制。
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“重试”（Retry）缺少的引用文件

一个“重试”（Retry）选项已添加到“找不到引用文件”（Reference file
not found）窗口。现在您可以查找缺少的引用文件，将其还原到原始被引用的
位置，然后单击“重试”（Retry）将其加载到场景中。

建模新特性

将对象发送到 Mudbox

现在，您可以使用“文件”（File）菜单中的“发送到”
选项将 Maya 对象发送到 Mudbox。在 Mudbox 中修改
对象后，可以再将该对象发送回 Maya。

通过“一键单击”功能，可以将包括网格和网格中的 UV
在内的各种形式的数据发送到 Mudbox。可以将这些数据
作为新场景或现有场景的更新发送。

Maya 的“发送到”选项是 Autodesk Entertainment
Creation Suites 中的一项功能。

“编辑网格”（Edit Mesh）更新

“编辑网格”（Edit Mesh）菜单中新增了多项更新，其中包括：
■ “在网格上投影曲线”（Project Curve on Mesh）选项，允许您将曲线投
影到多边形曲面。

■ “使用投影的曲线分割网格”（Split Mesh with Projected Curve）选
项，允许您分割和分离多边形曲面的边。
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■ “交互式分割工具”（Interactive Split Tool），允许您分割多边形网格
的面。

■ “挤出面选项”（Extrude Face Options）窗口中的新“曲线”（Curve）
选项，允许您自动生成和定位曲线。

“显示操纵器工具”（Show Manipulator Tool）更新

新增多个与“显示操纵器工具”（Show Manipulator Tool）关联的滑块，允
许您修改厚度、偏移和分段值。

标记菜单更新和新增内容

下表列出了 Maya 标记菜单的更新和新增内容。

更新/新增内容标记菜单

多边形边 ■ 增加了“翻转/自旋边”（Flip/Spin Edge）子菜

单。

■ 增加了“分离组件”（Detach Components）。

■ 增加了“连接组件”（Connect

Components）。

多边形面 ■ 增加了“指定不可见面”（Assign Invisible

Faces）。

■ 增加了“连接组件”（Connect

Components）。

移动、旋转和选择工具 ■ 移除了“软选择”（Soft Select）切换

■ 增加了“对象”（Object）模式切换

缩放 ■ 对菜单项重新排序

■ 增加了“轴”（Axis）子菜单，其中包括用于缩

放轴的选项。

■ 增加了“法线平均化”（Normal Average）、

“对象”（Object）和“世界”（World）缩放
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更新/新增内容标记菜单

■ 移除了“软选择”（Soft Select）切换

■ 增加了“对象”（Object）模式切换

多边形顶点 ■ 增加了“连接组件”（Connect

Components）。

UV 编辑器组件转化 ■ 移除了“到边框”（To Border）

■ 增加了“到 UV 循环边”（To UV Edge

Loop）。

动画新特性

可编辑的运动轨迹（Editable motion trails）

通过新的可编辑的运动轨迹，可以预览动画和以交互方式

调整 3D 场景中的关键帧。运动轨迹提供围绕动画模型的
关键帧的可视表示，使您可以直接调整动画的计时、关键

帧、切线和位置。

“曲线图编辑器”（Graph Editor）改进

“曲线图编辑器”（Graph Editor）中添加了多个新选
项和首选项用于改进曲线编辑工作流。特别是，使用多种

Autodesk 应用程序的动画人员有望提高各曲线编辑工具
之间的一致性。“曲线图编辑器”（Graph Editor）改
进包括：
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相邻关键帧捕捉

通过新首选项，可以将相邻关键帧设置为在编辑时自动对

齐。根据关键帧编辑样式，启用“将值捕捉到相邻关键

帧”（Snap Values to Adjacent Keys）以使类似相
邻关键帧捕捉到相同值。

自动切线类型

当在曲线图视图中移动关键帧时，“自动”（Auto）切
线会自动进行自我调整以确保平滑过渡，而不会超出最大

值和最小值。“自动”（Auto）切线可以在动画人员粗
略设计动画时节省其宝贵时间，因为切线会自然调整以避

免生成尖形突起。

该切线类型是多种其他 Autodesk 应用程序共用的，是新
关键帧的的新默认切线类型（在“动画”

（Animation）首选项中设置为“默认入切线”和“默
认出切线”）。

隔离选定的曲线

通过仅显示要处理的曲线，可以快速在曲线图视图中缩小

聚焦的范围。通过新的“曲线 > 隔离曲线”（Curves >
Isolate Curve）选项，可以轻松地仅查看选定通道的曲
线。

缩放多个关键帧

新的区域工具提供了可基于时间和值缩放多个关键帧的一

种简单、更直观的机制。从“曲线图编辑器”（Graph
Editor）工具栏中选择“区域工具”（Graph
Editor），选择需要的曲线区域，然后拖动区域控制柄
以进行缩放。

简化的工具栏选项

“视图”（View）菜单现在包含“经典工具栏”
（Classic Toolbar）选项，用于将“曲线图编辑器”
（Graph Editor）在经典工具栏、完整工具栏与更简化
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的工具栏（显示一组较少的选项）之间切换。对于主要使

用 Maya 作为套件一部分的动画人员来说，关闭“经典工
具栏”（Classic Toolbar）可以使曲线编辑工具的显示
更流畅。

此外，该版本还更新了多个“曲线图编辑器”（Graph
Editor）图标。

单击曲线编辑

默认情况下，新的“使用鼠标左键改变选择”（Left
Mouse Button Alters Selections）首选项处于启用
状态，单击一下就可调整选定的关键帧。通过启用该首选

项，只需单击一下并拖动即可在曲线图视图区域中移动选

定的关键帧。在其他 Autodesk 产品（如 MotionBuilder）
中使用过曲线编辑工具的动画人员会比较熟悉该关键帧操

纵模式。

切线类型反馈

“曲线图编辑器”（Graph Editor）现在提供有关选定
关键帧的切线类型的可视反馈。如果所有选定关键帧具有

相同的切线类型，“曲线图编辑器”（Graph Editor）
工具栏中将会亮显相应的切线图标。如果选定的关键帧具

有不同的切线类型，则不会显示任何反馈。

“摄影机序列器”（Camera Sequencer）更新

Ubercam

创建一个 ubercam 以使用单个摄影机播放序列中的所有
摄影机快照。

创建 ubercam 时，“摄影机序列器”（Camera
Sequencer）会将每个快照的摄影机参数烘焙到此单个
摄影机，这样可以保持摄影机切换。如果要修改快照中的

源摄影机，重新创建 ubercam 即可更新。
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“快照播放列表”（Shot Playlist）窗口

通过新的“快照播放列表”（Shot Playlist）窗口，可
以快速编辑摄影机快照参数，如快照长度或所使用的摄影

机。

其他播放预览选项

■ “播放预览序列”（Playblast Sequence）选项中
添加了“分辨率宽度”（Resolution Width）和
“分辨率高度”（Resolution Height）

■ 用于播放预览的“屏幕外渲染”（Offscreen render）选项

（“播放预览快照”（Playblast Shot）、“播放预览序

列”（Playblast Sequence）和“重新播放预览快照选项”

（Re-playblast Shot Options））。

多轨道音频

（仅 Windows 和 Linux）现在可以向序列中添加多个音
轨。

与Autodesk Smoke 的互操作性

通过“摄影机序列器”（Camera Sequencer）的多种
增强功能，可生成能导入 Autodesk Smoke 中的 XML 文
件。

同步的“通道盒”（Channel Box）、“曲线图编辑器”（Graph Editor）
和“时间滑块”（Time Slider）

通过“通道盒”（Channel Box）的“通道”（Channels）菜单中的两个新项
目，可以设置是否将您在“通道盒”（Channel Box）中做出的选择与“曲线图
编辑器”（Graph Editor）和“时间滑块”（Time Slider）同步。启用“同
步时间轴显示”（Sync Timeline Display）时，选择“通道盒”（Channel
Box）中的通道也会过滤“时间滑块”（Time Slider）以仅显示这些通道的关
键帧，并仅对选定的通道设置关键帧（如果设置关键帧）。启用“同步曲线图编辑

器显示”（Sync Graph Editor Display）时，“曲线图编辑器”（Graph
Editor）中将仅显示所选定通道的曲线。
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Craft Animations 插件

Maya 现在提供了来自 Craft Animations 的两个汽车和两个飞机预装备模型，以
及 Craft SoftMotionCam、ObserverCam、MultiStateCam 和 HumanizerCam
摄影机装备。

您可以使用这些交通工具装备快速设置现有的交通工具模型用于动画，使用自定义

输入设备控制交通工具，以及录制交通工具动作和摄影机装备的关键帧动画。

有关 Craft Animation 装备和摄影机的完整文档，请使用 Craft Animation Director
Studio 插件窗口中的“帮助”菜单。有关 Craft Animation 的详细信息，请参见
http://www.craftanimations.com。

运动捕捉示例

“Visor”窗口中现在包含附加的运动捕捉示例文件，可
以在角色动画重定目标工具中使用这些文件。

若要查找 Mocap 示例，请打开“Visor”（“窗口 > 常
规编辑器 > Visor”（Window > General Editors
> Visor）），然后切换到“Mocap 示例”（Mocap
Examples）选项卡。这些附加文件在导航面板中按男性
和女性角色分组组织。

装配新特性

新的 HumanIK 角色设置工具

增加了两个新的角色设置工具，来改进 HumanIK 角色工作流。这两个工具专用
于在现有 HIK 重定目标工作流上进行构建，以及为关键帧管理器添加新功能（例
如，关键帧组和装配同步）。
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选择“窗口 > 动画编辑器 > HumanIK”（Window > Animation Editors
> HumanIK）或“骨架 > HumanIK”（Skeleton > HumanIK），以便访
问这两个新工具以及现有的“骨架生成器”（Skeleton Generator）工具。

角色化工具

新的“角色化工具”（Characterization Tool）为角
色动画师提供改进的、更为直观的工具，可以更加方便地

映射和定义 HumanIK 角色的结构。

“角色化工具”（Characterization Tool）的设计可
以保持与其他 Autodesk 应用程序之间流线型的一致工作
流，它所提供的经过改进的错误报告以及直观的视觉界

面，可增强 HumanIK 角色动画的制作流程。

“角色控制”（Character Controls）窗口

新的角色控制窗口可用于提供在控制装配上与 FK 和 IK 效
应器交互的视觉界面。

“角色控制”（Character Controls）根据要处理的是
整个身体、指定身体部位还是仅当前选择，而激活不同的

操纵和设置关键帧模式。“体形”（Figure）表示可用
于提供持续的视觉反馈，该反馈有关对于设置关键帧、达

到和拉动值处于活动状态的角色部位。

其他控件可用于快速固定和取消固定控制装配效应器、创

建辅助和枢轴效应器，以及调整控制装配及其重定目标源

之间的达到和拉动特性。
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注意

在本版本的 Maya 中，除增加了卓越的全身装配和具有 HumanIK 的动画功能之
外，之前的全身 IK (FBIK) 解决方法也已移除。您仍可以使用 FBIK 装配来加载现
有场景，但默认情况下 FBIK 的所有菜单和选项都已从 Maya 移除。

有关 FBIK 的归档信息（包括对还原 Maya 中 FBIK 菜单和选项的说明），可以在
Maya 文档的“归档”页面（网址：http://www.autodesk.com/maya-docs-archive）
找到“全身 IK 参考指南”。

HumanIK 关键帧工作流的其他改进

■ “时间滑块”（Time Slider）、“曲线图编辑器”（Graph Editor）和
“摄影表”（Dope Sheet）中的设置关键帧组

■ 对动画层和重定目标工作流的改进

■ 自动关键帧支持 HIK 设置关键帧组

MotionBuilder 互操作性

现在可以使用发送到命令来在 Maya 和 MotionBuilder 之间传递 HumanIK 角色
数据。这意味着不再需要将角色从 Maya 导出到 FBX，即可将角色导入到
MotionBuilder。若要在 Maya“文件”（File）菜单中查看“发送到
MotionBuilder”（Send to MotionBuilder）命令，计算机上必须安装
MotionBuilder。

MotionBuilder 互操作性是 Autodesk Entertainment Creation Suites 的一个功
能。

移动关节时改进关节方向行为

移动关节时，父对象的关节旋转轴现在将自动调整，以便其继续指向骨骼的下方。

位于“移动蒙皮关节工具”（Move Skinned Joints Tool）和“移动工具”
（Move Tool）中新的“自动确定关节方向”（Automatically Orient
Joints）设置，可用于启用或禁用该行为。
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变形器增强

导出和导入变形器权重

现在可以采用 XML 的格式导出和导入变形器权重贴图。将新项目添加到“编辑变
形器”（Edit Deformers）菜单，可用于导出和导入蒙皮权重数据，从而为将
权重从一个角色网格传递到另一个角色网格提供一种简单的方法。

动力学和 nDynamics 新特性

常规

效果资源（Effects Assets）

Maya 现在包括许多称为效果资源的预设效果。在 Maya
资源框架和模拟工具集的基础上构建，效果资源代表了与

效果最相关的属性，使其易于进行场景自定义。可以在

“Visor”窗口使用效果资源。
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Maya 的 ICE 互操作性

Maya 现在包括单击可互操作工作流，可用于在 Maya 和
Softimage 之间传递数据。使用 Send to 命令，可以将场
景导出到 Softimage、添加 Softimage ICE 粒子或变形效
果，然后将场景发送回 Maya。

Maya 的 ICE 互操作性可用于充分利用 ICE（交互式创建
环境）来创建 Maya 场景的效果。

Maya 的 ICE 互操作性是 Autodesk Entertainment
Creation Suites 的一个功能。

新增 Nucleus 节点属性

Maya 2012 包括以下新增 Nucleus 节点属性：

变换属性（Transform Attributes）

Nucleus 节点现在包括“变换属性”（Transform Attributes）和其他 Maya
变换节点特性。现在，可以与场景中的其他对象创建父子关系。将变换节点设定为

另一个对象的子节点时，模拟将发生在 Nucleus 节点的局部空间而不是世界空间
内。“使用变换”（Use Transform）属性启用变换特性。

“使用变换”（Use Transform）处于启用状态时，可以设定“变换属性”
（Transform Attributes）属性，以指定 Nucleus 重力和风的场景位置。位于
由“平移”（Translate）X、Y 和 Z 值定义的位置的边界框决定受 Nucleus 力
影响的区域。

可见性

启用时，场景中出现箭头，以显示 Nucleus“重力”（Gravity）和“风”
（Wind）的位置和方向。当“使用平面”（Use Plane）属性处于启用状态时，
“可见性”（Visibility）还显示 Nucleus 平面的位置。
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PhysX for Maya 插件

Maya 现在包括 NVIDIA® PhysX® for Maya 插件，其可用于充分使用 Maya 场
景中的 GPU 加速物理模拟。插件可用于从 Maya 中创建的网格中创建动力学、运
动学和静态刚体。然后，可以将刚体对象和 PhysX 约束接合到一起。

PhysX 插件还包括运动学布娃娃模拟和 APEX Clothing。

PhysX for Maya 仅适用于 Windows 系统。有关 PhysX 详细信息，请参见
http://www.nvidia.com。

有关 PhysX for Maya 插件的文档，请浏览 PhysX 安装目录下的 Documentation
文件夹。

Maya 的 Digital Molecular Matter 插件

Maya 2012 现在还包括来自 Pixelux Entertainment™的 Maya DMM™ (Digital
Molecular Matter，数字分子物质) 插件。插件有助于创建非常逼真的包含多个交
互材质的破碎、毁灭和变形模拟。Maya 可用的 DMM 插件可解算多达 1500 个四
面体。

可以在 Windows、Mac OS X 和 Linux 系统中安装 DMM 插件。有关使用 DMM
插件的详细信息，请参见 http://www.pixelux.com。

流体效果

液体属性

可以使用许多新的“液体”（Liquids）属性生成外观和行为与真实液体类似的流
体效果。

这些新属性包括：

液体方法（Liquid Method）

使用新的液体模拟方法可选择最适合您的效果的解算器。

如果启用“启用液体模拟”（Enable Liquid
Simulation），可选择“液体和空气”（Liquid and
Air）或“基于密度的质量”（Density Based Mass）
作为“液体方法”（Liquid Method）。
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液体最小密度（Liquid Min Density）

使用“液体和空气”（Liquid and Air）模拟方法时指
定解算器区分液体和空气的密度值。液体密度计算为不可

压缩的流体，而空气计算为完全可压缩。

液体喷雾（Liquid Mist Fall）

对于密度小于“液体最小密度”（Liquid Min
Density）属性指定的值的流体，将向下力应用于流体中
的区域。将“液体喷雾”（Liquid Mist Fall）设定为
0 时，将不应用任何力。增大该属性值会增加向下力的强
度。

质量范围

使用“基于密度的质量”（Density Based Mass）模
拟方法时定义质量与流体密度之间的关系。“质量范围”

（Mass Range）值较高时，流体中的稠密区域会比空白
区域更重，从而模拟类似于水和空气的关系。
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张力力（Tension Force）

基于栅格中的密度应用模拟曲面张力的力。“张力力”

（Tension Force）类似于“密度张力”（Density
Tension），但“张力力”（Tension Force）通过将
少量速度添加到流体来修改动量，而不是修改密度值。

可以将“张力力”（Tension Force）与“密度张力”
（Density Tension）一起使用，以便在液体效果中创
建逼真的曲面张力。

密度张力（Density Tension）

将密度的范围平滑为圆形形状，使流体中的密度边界更明

确。可以使用“密度张力”（Density Tension）创建
类似于液体中的曲面张力的效果。

“密度压力”（Density Pressure）和“密度压力阈值”（Density
Pressure Threshold）

应用向外的力以使“向前平流”（Forward
Advection）可应用于流体密度的压缩逆向（尤其是沿
容器边界）。这样，属性会尝试在不影响密度的情况下保

持流体总体积。例如，如果在水箱模拟中没有足够的“密

度压力”（Density Pressure），则流体可能会出现收
拢或排水。

“密度压力阈值”（Density Pressure Threshold）
基于每个体素指定应用“密度压力”（Density
Pressure）的密度值。对于密度小于“密度压力阈值”
（Density Pressure Threshold）的体素，将不应用
“密度压力”（Density Pressure）。
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“启用液体模拟”（Enable Liquid Simulation）处
于禁用状态时，“密度压力”（Density Pressure）和
“密度压力阈值”（Density Pressure Threshold）
还可用于默认流体解算器方法。

流体“输出网格”（Output Mesh）性能改进和增加

Maya 2012 提高了网格性能并新增了输出网格属性。

网格方法（Mesh Method）

使用“网格方法”（Mesh Method），可立即选择用于
生成流体输出网格的多边形网格的类型。

网格平滑迭代次数

可以将平滑迭代应用于输出网格，以提高其曲面的质量和

均匀性。

流体输出网格性能改进

Maya 2012 提高了将流体对象转化为多边形网格时的性
能。使用“三角形网格”（Triangle Mesh）或“四边
形网格”（Quad Mesh）作为“网格方法”（Mesh
Method）时，这些改进的效果最为明显。

空气/燃料比（Air/Fuel Ratio）

设定完全燃烧一定量燃料所需的空气量。例如，燃烧一定

量的汽油所需的空气是燃料的 15 倍。若要模拟汽油火，
请将“空气/燃料比”（Air/Fuel Ratio）设定为 15。

可以从“内容详细信息”（Contents Details）属性的
“燃料”（Fuel）区域访问“空气/燃料比”（Air/Fuel
Ratio）。

新特性 | 23



“压力”（Pressure）和“压力阈值”（Pressure Threshold）

向“温度”（Temperature）栅格中添加了一个新的“压力”（Pressure）属
性，用于模拟气体温度的效果。“压力”（Pressure）属性模拟气体变得越来越
热并快速膨胀时引起的压力增加。

“压力阈值”（Pressure Threshold）基于每个体素指定应用“压力”
（Pressure）的温度值。对于温度小于“压力阈值”（Pressure Threshold）
的体素，将不应用“压力”（Pressure）。

可以从“内容详细信息”（Contents Details）属性的“温度”
（Temperature）区域访问“压力”（Pressure）和“压力阈值”（Pressure
Threshold）。

自动调整边界大小（Auto Resize Margin）

“自动调整边界大小”（Auto Resize Margin）指定在流体容器边界与流体中
正密度的区域之间添加的空体素的数量。“自动调整边界大小”（Auto Resize
Margin）可使流体在自动调整大小的边界附近流动更加自然，对快速移动和低密
度的流体非常有用。

自动调整大小的子步

使用新的“调整大小的子步”（Resize In Substeps）属性可以调整每个子步的
流体容器的大小。在早期版本的 Maya 中或“调整大小的子步”（Resize in
Substeps）处于禁用状态时，流体在每个模拟步骤只调整一个体素的大小。启用
“发射的子步”（Emit In Substeps）时，快速移动的流体会更为精确地调整
大小，尤其是在使用更多的子步时。

发射的子步（Emit In Substeps）

使用新的“发射的子步”（Emit In Substeps）可计算每个子步的流体发射，
而不是每个步骤计算一次。“发射的子步”（Emit In Substeps）对于发射速
度很快的效果（如爆炸）非常有用。

流体播放改进

通过对流体交互式绘制的改进，流体效果现在可以更快地播放。播放带纹理的流体

或缓存的流体效果时，性能改进最为明显。交互式绘制改进还加快了流体容器的实

时操纵（翻滚、推拉和旋转），尤其是对效果使用内部照明（禁用“真实灯光”

（Real Lights））时。
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nCloth

刚性 nCloth 壳

现在可以将“刚性”（Rigidity）和“变形阻力”
（Deform Resistance）应用到构成 nCloth 网格的单
个多边形壳。当由单个多边形壳组成的网格转化为 nCloth
时，新的“使用多边形壳”（Use Polygon Shell）属
性将对每个壳启用“刚性”（Rigidity）和“变形阻力”
（Deform Resistance）。然后这些壳将充当模拟时的
单个刚性对象。

“使用多边形壳”（Use Polygon Shells）可用于创建
简单的破坏效果以及其他刚性自碰撞效果。

“局部力”（Local Force）和“局部风”（Local Wind）

新的“局部力”（Local Force）和“局部风”（Local Wind）属性允许您对
单个 nCloth 对象应用重力和风。这些力只在局部应用，不影响指定给同一解算器
的其他 Nucleus 对象。

您可以使用“局部力”（Local Force）来减少或增加重力对特定 nCloth 对象的
影响，使衣服比角色着装的其他部位显得更亮或更暗。通过添加“局部风”（Local
Wind），可以使角色着装的特定部位产生大风效果，如飘动的斗篷。

碰撞上一阈值

新的“碰撞上一阈值”（Collide Last Threshold）属性设定碰撞迭代是否是
每个模拟步骤执行的最后一次计算。“碰撞上一阈值”有助于确保与 Nucleus 对
象的 nCloth 碰撞将在步骤结束时得到解决，从而减少后续帧中发生错误碰撞的机
会。

输入运动阻力（Input Motion Drag）

使用“输入运动阻力”（Input Motion Drag），可以将力应用于 nCloth，
nCloth 基于已设置动画的输入网格的运动。此力来自 nCloth 对象的当前速度与
其已设置动画的输入网格的速度之间的差值。“输入运动阻力”（Input Motion
Drag）值为 1 表示力将促使 nCloth 对象跟随其输入网格的相同路径。“输入运
动阻力”（Input Motion Drag）值为 0 表示不会对 nCloth 对象产生任何影
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响。使用“输入运动阻力”（Input Motion Drag）不需要设定“输入网格吸
引”（Input Mesh Attract）。

nCloth 性能改进

增加的 Nucleus 解算器线程可改进 nCloth 模拟的性能。使用连接到同一个 Nucleus
解算器的多个 nCloth 对象播放模拟时，性能改善最为显著。在这种情况下，自碰
撞表面和拉伸阻力的计算将按线程进行处理。

可绘制属性

已将一些属性添加到可绘制 nCloth 特性的列表中。现在，您可以使用“绘制
nCloth 属性工具”（Paint nCloth Attributes Tool）为以下属性创建顶点
贴图和纹理贴图：

■ 弯曲角度衰减（Bend Angle Dropoff）

■ 恢复角度（Restitution Angle）

■ 阻尼（Damp）

■ 升力（Lift）

■ 阻力（Drag）

■ 切向阻力（Tangential Drag）

nParticle

nParticle 性能提高（nParticle performance improvements）

附加的 Nucleus 解算器线程可以提高 nParticle 碰撞检测的性能，从而使大型
nParticle 模拟速度更快，特别是当“启用液体模拟”（Enable Liquid
Simulation）处于启用状态以及 nParticle 与其他 Nucleus 对象发生碰撞时。

“局部力”（Local Force）和“局部风”（Local Wind）

通过新的“局部力”（Local Force）和“局部风”（Local Wind）属性，可
以将重力和风应用到各 nParticle 对象。这些力会在局部应用，不会影响指定给同
一解算器的其他 Nucleus 对象。
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粒子颜色发射增强功能（Particle color emission enhancements）

现在，可以使用“纹理发射属性”（Texture Emission Attributes）（如“继
承颜色”（Inherit Color）或“继承不透明度”（Inherit Opacity））为从
所有发射器类型发射的粒子上色。在 Maya 的早期版本中，这些属性只能用于“表
面”（Surface）发射器。要使用“继承颜色”（Inherit Color）或“继承不
透明度”（Inherit Opacity），必须断开相应内部着色渐变与 nParticleShape
节点的连接。要执行此操作，请在“每粒子(数组)属性”（Per-particle (Array)
Attributes）中的每粒子属性上单击鼠标右键，然后选择“断开连接”（Break
Connection）。

Maya 经典粒子也支持这些增强功能。

渲染和渲染设置新特性

Viewport 2.0 新特性

“Viewport 2.0”新特性包括对 Maya 的大多数部分
（例如，操纵器、工具、形状和节点）的改进支持。

提供了两个新的性能选项：“顶点动画缓存”（Vertex
Animation Cache）选项提供了对动画的更具交互式
的拖动，而“线程依存关系图求值”（Thread
Dependency Graph Evaluation）选项则通过对单
独线程中的单独角色求值而提供更好的性能。

提供了对插件形状、硬件着色器和定位器的新的 API 支
持。在视口中提供了对 mia_material_* 着色器和其他
mental ray 着色器的近似支持。新的效果包括屏幕空间环
境光遮挡、运动模糊、景深以及多采样抗锯齿。

此外，使用新的“Maya 硬件 2.0”（Maya Hardware
2.0）渲染器可以执行“Viewport 2.0”的命令行渲染，
或批渲染到磁盘或“渲染视图”（Render View）。可
以使用下列几种方式访问“硬件 2.0”（Hardware
2.0）渲染器：从“渲染视图”（Render View）窗口、
“渲染设置”（Render Settings）窗口和“脚本编辑
器”（Script Editor）访问，通过命令行渲染器访问，
或通过选择“渲染 > 批渲染”（Render > Batch
Render）访问。
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在渲染视图中预览合成

现在可以通过“Hypershade”轻松地创建渲染过程节
点，并直接在“渲染视图”（Render View）中查看这
些过程的输出。另外，还可以通过使用渲染过程和标准

Maya 着色工具节点来创建基本的合成图，并直接在“渲
染视图”（Render View）中可视化结果，或者使用新
的渲染目标节点进行批渲染。

向量置换贴图

在 Maya 中将向量置换贴图连接到着色组可创建在任意方
向上包含置换的复杂雕刻曲面；例如，创建底切或悬垂特

征。可以在 Mudbox 或任何类似软件中创建向量置换贴
图。

可以将该功能与任何 Maya 或 mental ray 着色器一起使
用；但无法在场景视图中可视化向量置换贴图，并且必须

使用 Maya mental ray 进行渲染。

对 Ptex 纹理的支持

使用 Maya 2012 可以预览在 Viewport 2.0 中指定给任何
标准 Maya 着色网络纹理输入的 Ptex 纹理。
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新的 mental ray 渲染手册

所有 mental ray 着色和渲染文档已移至新的 mental ray 渲染手册中。mental ray
特定节点和属性描述已移至 mental ray 节点属性一章中。

仅当加载 mental ray 插件之后才可访问 mental ray 属性

以前，不管是否加载了 mental ray 插件，都可在节点的“属性编辑器”
（Attribute Editor）中访问所有 mental ray 属性。

从 Maya 2012 起，仅当加载 mental ray 插件 (Mayatomr.mll) 之后才可访问
mental ray 属性。

Maya mental ray 用户应确保在“插件管理器”（Plug-in Manager）中将
Mayatomr.mll插件设定为“自动加载”（Auto load）。

mental ray 支持压缩的 .tif 文件

Maya mental ray 现在支持输入 LZW 压缩的 .tif 纹理文件。

EXR 版本 1.7 支持

在 Maya 2012 中提供对通道名称长度为 252 个字符的 EXR 版本 1.7 支持。若要
使用该选项，请创建 MAYA_EXR_LONGNAME 环境变量并将其设定为 1。但是，
必须确保所使用的任何其他应用程序也支持该标准。

API 新特性

扩展属性

自 Maya 2012 开始，您可以使用新的扩展属性要向给定节点类添加属性，使其显
示为静态 Maya 属性。

还可以通过 API MDGModifier 类来添加或移除扩展属性。或者，可以使用
MEL/Python addExtension和 deleteExtension命令进行。
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新增API 帮助功能

API 手册和 API 参考现在是 Maya 帮助的独立部分，可以在
http://www.autodesk.com/maya-sdkdoc-2012-enu中查找。此外，API 帮助包括以
下新特性：

■ 从 API 手册到 API 元素的链接有所增多（例如，类和功能）。

■ API 手册中示例代码中采用了颜色编码语法。

■ 目录表中包含 API 参考。

■ 搜索速度有所提高。

QT 新特性

■ Qt 现在使用 4.7.1 版本。

■ 支持自定义 Qt 控件和 Qt Designer 一起使用。

■ 对于 Windows 和 Linux 用户，Qt Designer 随 Maya 一起安装。对于 Mac
OS X 用户，可以直接在 Qt 开发工具网站中获取 Qt Designer；或者可以使用
源构建 Qt。要找出已经由 Autodesk 做出修改（以包含 Maya UI 所需更改）
的 Qt 源代码版本，请参见自定义界面。

MEL 和 Python 新特性

请参见该文档的 HTML 版本以了解已增加、删除和更改的 MEL/Python 命令的列
表

文档新特性

Autodesk.com 上的 Maya 帮助

从本版本开始，Maya 帮助将发布到 Autodesk.com 网站上。默认情况下，Maya
2012 从一个 Web 位置调用帮助以为您提供可用的最新文档。改为直接发布到 web
意味着我们可以随时对文档内容进行更新和补充。此更改还大大减少了计算机上本

地安装的数据占用空间，并且使安装和卸载 Maya 更迅速。

喜欢本地副本的用户可以使用 2012 Maya 帮助的下载版本。
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YouTube 上的 Maya 教学频道

现在 YouTube 上提供了专用的 Autodesk Maya 教学频道，它提供 Autodesk 制
作的可信内容。该频道提供关于各种工作流、功能和互操作性主题的视频流。新视

频定期发布；订阅频道以接收通知。

■ www.youtube.com/mayahowtos

联机文档归档

Maya 帮助的若干尚未更新的章节现已在联机归档中提供。若要访问归档，请参见
http://www.autodesk.com/maya-docs-archive。

API Guide 和 mental ray Manual 的新位置

API Guide、Maya API Reference 和 mental ray Manual 现在独立于 Maya 帮
助。

■ API Guide 和 API Reference：http://www.autodesk.com/maya-sdkdoc-2012-
enu

■ mental ray Manual：http://www.autodesk.com/mentalray-help-2012-chs

FBX 文档

从本版本开始，所有 FBX 帮助文档均在网站上提供，而不用本地安装。

请单击插件中的“有关 FBX 的帮助”（Help on FBX）按钮访问联机文档。

“Autodesk FBX 帮助”选项已从“Autodesk Maya 帮助”菜单中移除。现在您
将发现 FBX 信息成为 Maya 帮助的一部分。

新特性 - 先前的版本

新特性 - 先前的版本

若要查看先前的 Autodesk Maya 版本中的新特性，请参见
http://www.autodesk.com/maya-whatsnewdocs。
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